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Introduction 
The target of this material is to give you a good overall picture of the various features 
of your computer, Windows Vista operating system and the desktop. This material is 
suitable for 24-35 hour courses, but it also is a useful tool for shorter training courses. 

Studying goals 
You should set goals for your studying. The goal of this material is to make you  
familiar with the basics of Windows Vista. The material introduces you to the most  
important features and functions useful for automatic data processing. 

After carefully familiarizing yourself with the material you can: 

 Use the Start menu; start and shut down the programs 
 Use input devices, keyboard and mouse 
 Use Taskbar and switch between programs  
 Perform basics Windows Explorer tasks; create new folders and files, search 

and handle them (Disk management)  
 Save files and open, close and handle them. 

Set goals for your learning. You get most of your studying, when you are target-
oriented and motivated. This way learning new things will be easier and more efficient 
for you. If you find the subjects useful, you will also remember them better in the fu-
ture. To reach your own goals, you should be active and participate in improving the 
course by presenting questions and ideas. 

I wish you pleasant and enjoyable studying! 
Kari J. Keinonen 

Why do you need the operating system? 
To be able to work on the microcomputer you need a disk operating system. The disk 
operating system controls the computer, so that the other programs can use it. The 
task of the disk operating system is to transform: 

 the commands you give into a form that the computer understands and 
 the data the computer handles into a form that you understand. 

With the start up of the computer, Windows operating system will be loaded from the 
hard disk into the main memory. It will control the programs and peripherals. In 
Windows Vista, a graphic user interface, a desktop, has been built for the users. With 
the help of the desktop it is easier for you to use the operating system. You don’t 
have to remember the commands to control the computer. 

The tasks of the operating system are: 

 Starting the programs 
 Controlling the peripherals 
 Memory management of the computer 
 Processing the files 
 Transferring the data from one program to another 

You create files with the programs in your computer. When these files are printed, 
they are called documents. 
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Start Up and Shut Down of the computer 
Start Up 

1 Firstly, switch on all the peripherals, also the screen. 
2 Switch on the central processing unit. 
3 The system will be loaded into the main memory. 
After a while, a dialogue box will appear on your screen. Please select your user ac-
count by clicking and type your personal password. If your original password is writ-
ten in small letters, you must always type the password in small letters. 

Home computers do not normally have passwords. Therefore, The Windows Desk-
top will automatically appear. 

After you have given the correct log-in information, the computer will start up and 
The Desktop (picture on page 10) will appear. The use of the computer is done at 
the desktop. 

 

Shut Down 
1 Quit the data processing by shutting down all the programs. Save all the files 

you have created when exiting the program. 
2 On the Start menu, select the Shut Down or press Alt + F4 keys. 
 

You don’t have to use the power button to shut down the computer, modern com-
puters shut down with the Shut Down command automatically. 

By using Restart on the Start menu you can restart the computer. On the Start menu 
you will also find Log Off which logs off your user account. This is necessary espe-
cially with the multiple access computers. 

It is also often necessary to restart the computer, when the programs crash. In this 
situation you should press Ctrl + Alt + Del. In the appearing dialogue box, click 
Shut Down on the bottom right hand corner, and select Restart. 
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Data processing orientation 
In electronic data processing you will enter information into the computer by using 
the mouse or the keyboard. You will handle and enter objects, which can be selected 
and handled as a whole. As a device you will use computer programs and databases. 
The processor in the central processing unit will process the information you have  
entered. The computer will then write out the information on screen and/or paper. 

 
Figure 1 In the picture you can see the data processing orientation. Computer data 

processing differs from the traditional typewriter data processing as far as 
the functions in the middle are concerned. When using the typewriter, the 
information is not being processed in the processor, but you see the re-
sults of your work e.g. on paper. 
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Input device 
Mouse and keyboard are the input and control devices of your computer. With both 
of them you can enter information and execute commands. 

Keyboard 
Function keys 

Function keys are used for controlling (using) both the operating system and the pro-
grams. By pressing F1, help for Windows or program will pop up. If you press F3 
while at the desktop or Windows Explorer, Search Results dialog box will appear. 
With the help of the dialog box you can search for information on the disks by differ-
ent search criteria. 

Numeric keypad 
These keys are used for entering numerical values and operands (+ - / *) into the 
charts. 

Cursor control keys 
Cursor control keys are used to move pictures on the screen, at the same time the 
cursor will move. At the new position of the cursor you can change the file. In many 
programs the Home key takes you to the beginning of the line and the End key to 
the end of the line.  

QWERTY 
With the help of QWERTY you can enter characters into the files. It is good to re-
member a couple of shortcut combinations in order to control the computer by using 
the keyboard. The shortcut combinations usually consist of Shift, Ctrl and/or Alt to-
gether with some basic keyboard key. Using the shortcut keys will speed up your 
work. Press the F1 key and you'll get additional information about using the shortcut 
keys by using the index word Shortcut keys. 
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Mouse 
Cursor 

When you move mouse the cursor moves on the screen. Please find examples of the 
shape of the cursor below: 

 

Pointing 
Move the cursor over the object. 

Click 
Click the left mouse button and release it. By clicking you activate the object, open a 
pop-up menu or execute a menu command. 

Dragging 
Move (drag) the mouse, either the left or right mouse button pressed down, so that: 

 the chosen object moves along (left button) 
 the cursor chooses the key string or other objects (left button) 
 the context menu will pop up (right button), and you can choose any function 

you want. 

Double click 
Click the left mouse button quickly twice. With Double click you can open files, 
folders or select whole words. You can choose a word by double-clicking it. 

Clicking the right mouse button 
By clicking the right mouse button you can make the context menu of the object to 
pop up. On the context menu you can choose different functions related to the ob-
ject. 
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Windows Desktop 
After studying this section, you are familiar with the Windows Vista Desktop and 
you can use different Windows objects. You can open and close programs and use 
windows and folders. You also know menus and commands, taskbar and function 
keys. Additionally, you know the status line and the icons. 

 
 

 
 
 

Figure 2 In the picture there is the Windows desktop and its objects (parts, elements). At the bottom 
part of the window there is the Taskbar and the Start menu. They are the key to use the op-
erating system. With the help of the Start menu you can access the whole wide cyber world 
(Internet Explorer program), the Intranet of your workplace (Network program) and you 
can open the installed programs and work with them. By using the tabs of Taskbar you can 
move from one open program to another. With the help of the Recycle bin you can delete 
everything you find unnecessary. 
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Start menu 
At the bottom of the desktop there is the Taskbar. At the left end of the Taskbar 
there is the Start button. By clicking the Start button or the Windows key (at the 
keyboard), a drop-down menu will appear, where you can open the programs you 
want by clicking the command line. If you don’t see the program you're looking for in 
the list, click open the All Programs submenu, where you can find all the programs 
installed to your computer. 

 
 
 

Figure 3 In the picture there is the Start menu of Windows Vista. At the lower 
left section of the menu there is the All Programs button. By clicking 
the button you can see all the programs, which are installed on the com-
puter. In the right pane there are functions, which help with the use and 
settings of the computer. 

On the Start menu there are other important functions, too. The Shut Down com-
mand shuts the computer down safely. By using the commands in the right pane of 
the menu you can open the files that you have recently opened. By clicking the Con-
trol Panel command you can change the settings of the operating system. You can 
use the Help and Support command to open Windows help, familiarize yourself 
with it. 
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Using Taskbar 
Windows Vista is a multiprocessing operating system. It means that you can use many 
programs at the same time. You can see all the programs that you can use at the 
Taskbar. You can switch between programs by clicking the program buttons at the 
Taskbar. 

The Taskbar is situated at the bottom of the screen. You can move Taskbar to the 
upper section of the screen by dragging it (I recommended). Moving the Taskbar re-
quires that you first unlock the Taskbar by clicking Lock the Taskbar at the context 
menu of the Taskbar. Drag the Taskbar up using on its empty part. After moving the 
Taskbar, lock the Taskbar again by clicking Lock the Taskbar. 

 
Figure 4 In the left corner of Taskbar there is the Start menu. Next, there are the 

Quick Launch buttons. You can add the programs that you want to the 
quick launch buttons. At the middle of the Taskbar there are buttons for 
open programs, by clicking them you can switch between programs. In 
the right corner there is the Notification Area. By clicking it with either 
the left or right mouse button you can open a menu, where you can 
change the settings of the accessories. Some accessories of the Notifica-
tion Area can be opened by clicking, others by double-clicking. 

The number at the beginning of the name of the Taskbar's program button means 
that several copies of the files are open. In the right corner of the program button 
there is a triangle upside down. The triangle you can make the files appear by clicking. 
The name of a file you can start processing the file by clicking. 
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Windows 
In Microsoft Windows, windows are the places where all the work is done. All win-
dows are being handled in the same way. The same principles also apply to other op-
erating systems equipped with a graphic user interface. 

 
 

 
 
 

Figure 5 You can move the window by dragging the title bar. In most of the win-
dows there is a menu bar at the upper section. If the menu bar is not vis-
ible, press the Alt key. This menu bar has all the commands necessary for 
handling the windows (programs). 

 You can change the size of the window by using the control buttons or 
by dragging the borders or angles of the window. The Maximize button 
you can enlarge the window to be the size of the screen by using. The 
Minimize button you can diminish the window to fit the taskbar by using. 

 With the help of the scroll bar you can make the hidden contents of the 
window to appear. You can close the window by using the Close button. 
There is a status bar at the bottom of the window, if it has been made to 
appear in the settings. The status bar gives you useful information and in-
structions. 
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Context menu 
Context menu is Windows' most important auxiliary function. Context menu is a 
context-specific menu, where you can see the commands available to handle the ob-
ject. Context menu appears, when you click the right mouse button on the object or 
press the Context menu key on the keyboard. There is Properties command in the 
context menu of nearly all objects (often last command). You can adjust the settings 
of the object (pages 16 and 25) with the help of this command. 

The Context menu function is available everywhere in Windows, both in the operat-
ing system and the desktop programs. You can work much more effectively, when 
you learn how to use the context menu to execute the commands. 

 

Figure 6 In the picture, the Recycle Bin icon has been right-clicked. The context 
menu of the Recycle bin will appear, and there are commands for pro-
cessing the bin. After you have moved the files, which you want to delete, 
to the Recycle bin, you can empty the recycle bin by clicking Empty Re-
cycle Bin. 

 
 

 

Figure 7 The most important command of a disk, folder or file is Properties. 
With the help of this command you can see the size and other important 
information of the chosen object. 
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Windows Explorer 
In this section it is my goal to familiarize you with the file management in the hierar-
chical tree structure of Windows Explorer. 

The Windows Explorer program shows all the resources of the computer in one 
tree: disk drives, network drives, network device, printers, folders and files. 

Windows Explorer can be started by clicking on the Start menu  All Programs  
submenu Accessories command or by pressing Windows + e. 

Windows Explorer window 
 
 

 

Figure 8 At the picture you can see the Windows Explorer window and its parts. 
By clicking the triangle in the tree of the directory window you can open 
the disk or folder and see the contents of the resource in the file window. 
You can minimize and maximize the windows with the control buttons. 
By pressing the Close button you close the window. You can make the 
menu bar to appear by pressing the Alt key. 
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Disk Drive 
Disk drives are named with disk drive codes, which are familiar from old operating 
systems (in brackets). 

 A: (and B:) Disk drive for 3.5 inch diskettes 
 C: Start Up hard disk 
 D: tai E: Often CD or DVD drive 
 F: - Z: Other disk drives (memory sticks, external hard disks etc.) 

 
Figure 9 By clicking the Computer icon you can see the contents of your comput-

er in the file window. The disk drives have an explicit name in addition to 
the names familiar from the DOS system. You can display the menu bar 
by pressing the Alt key. 

Disk drive properties 
By clicking the disk drive icon with the right mouse button you can make the context 
menu appear. Click the Properties command. 

  

Figure 10 In the picture you can see the properties of the KINGSTON (D:) drive 
on the General tab. You can name the peripherals in the name box. In 
the middle of the window you can see the size, used space and free space 
of the disk. 

There are many tabs in Properties dialog box . Familiarize yourself with the contents, 
but don’t change the settings unless you are sure it's useful. 
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Folders 
To the disk drives you can create directorial structures, where you can create folders. 
In these folders you can save all you work, in other words the files. Name the folders 
and files carefully according to their contests. For additional information on naming, 
please see the files on page 19. 

 
Figure 11 In the file window you can see the contents of the directory D:\My 

own\Others. After clicking Location you see the path of the folder tra-
ditionally presented. D: means disk drive, under (\) which there is the 
folder My own under which there is the subfolder Others. The ob-
jects in the file window have been sorted by the name, but not grouped. 
At the bottom part of the screen there is the Details Pane, where you 
can see the number of the objects in the chosen folder. 
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Files 
Files are pieces of work, which have been created by using applications. They can be  
handled and saved electronically, and when they are printed they are called docu-
ments. 

 
Figure 12 The Folder D:\My own\Others has been chosen. On the right you can 

see the contents of the folder: files (1) and subfolders (2). The menu bar 
will appear when you press the Alt key on the keyboard. If you activate a 
single object in the folder, you can see the details of the chosen object in 
Details Pane at the bottom of the screen. 

Files (and folders) can be opened in Windows Explorer by double-clicking the icon 
of the file. At the same time you will open the application, which you have used to 
create the file. 
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File management  
You can handle and manage the files in the Desktop. Files are managed best with the 
Windows Explorer. The easiest way to open the Explorer is to press the Windows 
+ e key combination. 

File management means organizing the contents of the files and directory structures 
in meaningful order. File management also means handling the folders and files, in 
other words creating, searching, copying, moving, deleting and naming them with de-
scriptive names. 

It is important that you save the programs in separate folders. You should name the 
files you have created in folders that you have carefully named. 

File and folder names 
Files and folders (also other objects like disks) should have descriptive names. Name 
the files logically when you save them, and place them in the right folders. Naming of 
the files and folders can be done quite freely, Windows Vista limits the name length 
to 215 characters (maximum 256 characters including the file path). You should name 
the files and folders reasonably and give them short names; the recommended length 
is 32 characters or less. 

Old MS-DOS naming rules  
It's useful for you to know the old MS-DOS naming rules. They will help you espe-
cially if you use the files in old operating environments. 

File name can have 
 no more than eight (8) characters 
 alphabets a ... z 
 numbers 0 ... 9 
 special characters _, %, & or ! 

File name cannot have: 
 Scandinavian characters å, ä and ö 
 other special characters like space, - . +, * : ; / | \ ( ) etc... 
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Diskette handling 
A diskette is a storage medium, where you can save a lot of information. Using 
diskettes is rather rare nowadays, but is still quite an eligible storage medium. The 
most common diskette is the 3,5 inch HD diskette (1,44 MB diskette). With the help 
of the diskettes you can transfer information from one computer to another and back 
up files made earlier. If you transfer information to another environment, you have to 
check  whether there is a diskette drive in the computers in question. 

You should format it before you start using the diskette. Formatting prepares the disk 
so, that it can receive information. Formatting also empties the diskette. By format-
ting the diskette you also check its condition. If the formatting succeeds, you can use 
the diskette safely. Remember that you can store information on a disk only for a lim-
ited period of time. That time varies from 3 to 15 years depending on the diskette and 
the storage conditions of the diskette. 

You can format the diskette by clicking Floppy Disk Drive icon in the directory 
structure with the right mouse button. Some other drive must then be active. Choose 
Format command on the context menu. Make the settings you want in the appearing 
dialog box and click Start. 
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Creating a new folder  
You should create an organized tree structure on the hard disk where all your pro-
grams and files are in their respective folders. It is useful to create a folder for the 
memory stick and CD disk; otherwise it is hard to find the information. 

You can create a new folder under the selected folder by selecting the Folder com-
mand on the New submenu on the context menu. You should give the folder a de-
scriptive name and accept it by pressing the Enter key on the keyboard. 

Selecting files and folders 
Files and folders can be selected by clicking the mouse. 

Several files and folders can be selected one by one by keeping the Ctrl key down and 
clicking the file icons in the window. Several files can also be selected by drawing a 
frame around the files and folders. 

All the open files can be selected at once by pressing the Ctrl + A key combination 
on the keyboard. 

Copying files (Ctrl + c)  
Information is expensive, not computer. Files and folders can be copied to ensure the 
back up. When you store the information you have created in two places, losing the 
other one will not be dangerous or expensive. 

Copy the files and folders into the disk or memory stick. You can copy files also into 
CD or DVD disks, if your computer has a burning drive. With these storage media 
you can easily carry information with you. It is necessary when you want to work on 
two different computers, for example at work and at home. Be careful when carrying 
these media with you, so that they are not lost and the information doesn’t fall into 
the wrong hands. 

You can copy files and folders in the Explorer file window. Select one or more files 
or folders. Click first on the Edit menu and then the Copy command or press the 
keyboard shortcut Ctrl + c. Open the folder, in which you want to copy the files and 
folders. Click Paste command in the Edit menu or keyboard shortcut Ctrl +v. Copy-
ing files means multiplying the information. 

Copying can also be made using the mouse. You can drag the files and folders to the 
desired folder pressing and holding down the Ctrl key. In the bottom right hand cor-
ner of the icon, that you are dragging, there is a plus character showing that you are 
copying. 
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Moving files (Ctrl + x) 
You should move your files to logical locations. When you files are located in the 
folders according to the subjects, you can easily find the information you need by 
browsing the directory structure. 

When you move a file to a disk or a memory stick, it is easy to take along with you. 
After this, the file doesn’t exist in your hard disk any more. 

When moving the files and folders from the opened folder, select one or more files or 
folders. Select the Cut command on the Edit menu or press the keyboard shortcut 
Ctrl + x. Open the folder, where you want to move the files or folders. Select the 
Paste command on the Edit menu or press keyboard shortcut Ctrl + v. Moving the 
files changes their location. 

You can move files and folders also by using the mouse. Select the file or folder and 
drag it to the folder you want holding down the Shift key. When you move a file or a 
folder to another folder in a same drive, you don’t have to press the Shift key, in this 
case dragging is moving - but be careful! 

Removing files  
You can remove a file (or folder) by dragging it over the Recycle Bin icon. The se-
lected file will also be removed by pressing the Del key. The file will not be complete-
ly removed from the drive by using either of these methods. Therefore, the Recycle 
Bin must be emptied from time to time to remove the files from the drive. Emptying 
the Recycle Bin can be done using the Empty Recycle Bin command on the context 
menu of the recycle bin. 

You can remove the file (folder) from the drive once and for all by dragging the icon 
over the Recycle Bin holding the Shift key down. Then answer the warning window 
OK. The selected file can be removed from the drive for good also by pressing the 
keyboard shortcut combination Shift + Del. 
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Searching files (F3) 
Chasing for the lost file can be rather hard. Be careful already when saving the files. 
Save files by names that describe the subjects logically.  

Recently used files 
Windows Vista collects the 15 last used files into the Recent Items submenu on the 
Start menu. Many programs collect similar lists on files opened in the program. 

 

Figure 13 Open the Start menu and click Open on the Recent Items submenu. If 
you find the file you are looking for, open it by clicking the command 
line. 

Substitute characters (Wildcards) 
Substitute characters are asterisk (*) and question mark (?). 

Asterisk (*) 
Asterisk character (*) replaces any character string. You can use an asterisk when you 
want to find all files and folders whit any name. 

Additional instructions for file searching 
Additional instructions for searching files and folders can be found in the Start 
menu’s Help and Support service with the search phrase Tips for finding files. 
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Renaming files  
When you are creating files and folders, you often give them names, which you want 
to change later. When naming the folders, give them proper names describing the 
subject of the files in the folder. Give the files names, which describe the contents. 

To change the file name, click double times (not too quickly) the name line to select 
the name. You can also select the name by pressing the F2 key. The chosen name will 
be replaced with the new name you typed. You can move in the name line by clicking 
the place you want with the mouse. You can also move by pressing the End key, the 
Home key or the arrow keys on the keyboard. Like this, you can add characters to the 
beginning, between or in the end of the name characters. 
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Properties of folders and files 
Display the context menu by right-clicking the folder or file. Click the Properties 
command on the context menu. 

 

Figure 14 In the picture you can see the properties of the My own folder in drive D: 
shown on the General tab. Name the folder in the name box. In the mid-
dle of the dialog box you can see the size of the folder, its size on the disk 
and how many files and subfolders the folder contains. With the help of 
the attributes you can hide a folder or file. You can also make them only 
readable with the Read-only command. 

The Microsoft Windows Help tells that "setting to Read-Only can help protect a file 
from unintentional or unauthorized changes". When the file is set to read-only, it 
cannot be changed. 
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Compressing files and folders 
It is often useful to compress the files and folders. Compressing reduces the size of 
the file even by 90% at its best, often at least by half. Not all types of files are com-
pressible, for example photographic images (e.g. JPEG). This is because they already 
are compressed. It is quicker to send smaller files as e-mail attachments. Smaller files 
can also be downloaded quicker from the network. Vista has a separate function for 
compressing and uncompressing. The extension .ZIP in the end of the file name tells 
you that the file is compressed. 

Microsoft Help tells that "you can combine several files into a compressed folder, 
making it easier to share a group of files, since you only need to attach one folder to 
an e-mail message instead of several files. You can work with compressed files and 
folders in the same way that you work with uncompressed files and folders.” 

You can compress the files or folders by first selecting one or many files or folders. 
First select the Send to submenu from the context menu and then click on the Com-
pressed (zipped) Folder command.  
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Creating Shortcuts 
A shortcut is a link to the original file. By double-clicking the shortcut, you open the 
original program and file. Shortcut is like any other icon, and you can handle it in the 
same way. You can change the name of the icon, remove it or move it. If you move 
or remove the original file, the shortcut will no longer work. 

If you often use same files or folders, create a shortcut on the desktop or in a folder 
in the drive. You can create shortcut to most file types, also to Internet addresses. 
You can easily create a shortcut by dragging the file or folder to the desired location 
holding down the right mouse button. 

  
 

Figure 15 Drag the file icon to the desktop holding down the right mouse button. 
Click Create Shortcuts Here command. An icon of the shortcut will be 
created on your desktop. You can distinguish a shortcut from the original 
file by an arrow which appears in the left corner of the icon. 
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Office tools basics 
You produce data files by using applications  

Data, in other words files, are created by using office tools. The most important 
applications are word processing, spreadsheet and database programs. All information 
created in your work community is valuable, one year of your work costs over 35.000 
euros to your community. 

Created information must be found 
It is important to find the information. It is easier to find the information, when it is 
saved in a logical location. Give the files logical names describing the contents of the 
file. 

Information must be secured 
As there is always a risk that the computers might be damaged, it is important that 
the valuable information is secured. Your home computer the hard disk is a logical 
location to save the information, in organizations the information is normally saved 
into the server of the network. 

You can change information created earlier 
If you have worked with information for years, you have done many things already. 
The documents you have created earlier can often be used as good templates for new 
documents. Therefore, it is good to look for the existing information first before 
starting to create a new one. By editing old information and copying parts of it you 
can save a lot of time. 

Unnecessary information must be removable 
When some piece of information becomes out-dated and/or unnecessary, you have 
to be able to remove it. Unnecessary information must be removed, so that you don’t 
mix it with new information and that your computer doesn’t run out of space. 
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Using programs 
By using the programs you can create files, for example documents with text, calcula-
tions, registers, data bases, drawings or music. All the programs that are installed into 
your computer function with the same principles. You open and close the program 
always in the same way. You copy or move the objects in the files always in the same 
way. The Undo command functions in the same way in all programs. 

Opening programs  
You can open a program on the Start menu's All Programs submenu. Click the 
command line in the program group. This way you can always create a new file when 
opening the program, you can see it in the program window. 

Opening files (Ctrl + o)  
You can open the files you want by selecting the Open command from the Microsoft 
Office 2007 Office button, clicking on the Open button or pressing the keyboard 
shortcut combination Ctrl + o. 

Saving files (Ctrl + s)  
Save the necessary files into the hard disk. Save the files by selecting the Save com-
mand from the Microsoft Office 2007 Office button, clicking on the Save button or 
pressing the keyboard shortcut combination Ctrl + s.  

Printing files (Ctrl + p) 
You can print the necessary files on paper. Print the files use by selecting the Print 
command from the Microsoft Office 2007 Office button, clicking on the Print but-
ton or pressing the keyboard shortcut combination Ctrl + p. 

Closing files (Ctrl + F4) 
When you open the program, a file window will appear "floating" in the program 
window. Close the file window by selecting the Close command from the Microsoft 
Office 2007 Office button, clicking on the Close button or pressing the keyboard 
shortcut combination Ctrl + F4. 

Exit programs (Alt + F4) 
You can close Windows programs by selecting the Exit command from the Office 
menu or clicking the Close button in the end of the header line (picture on the left). 
You can also close the program with the keyboard shortcut combination Alt + F4. 
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Essential working principles 
All of us make mistakes. Therefore, programs have the Undo function. By using this 
function you can return to the previous situation. 

When you are using computers, never type the same text or draw the same picture 
twice. Use the Copy, Cut and Paste functions in the programs. With the help of these 
functions you never have to write the same contents twice. 

Undo (Ctrl + z) 
All programs have the Undo function to undo the mistakes you have done. Use this 
function to undo a mistake a mistake just after it was made or at least when you no-
tice your mistake. You can also undo with the keyboard shortcut Ctrl + z. 

In most programs the Undo function operates so, that you can undo several consecu-
tive functions. 

Copying (Ctrl + c) 
When you are creating documents on a computer, you probably create contents 
which you can also use in other documents. Copying text from old documents to new 
ones will save a lot of your time. You can also copy all contents of a document by 
opening a file created earlier and by renaming it. This way you can get the most bene-
fit from everything that you have done earlier and you can edit it as you want. 

Four steps of copying: 
1 Select an object (text etc.) 
2 Copy it by clicking the Copy button or pressing the keys Ctrl + c. 
3 Choose the location where you want to place the object. 
4 Place the object by clicking the Paste button or pressing the keys Ctrl + v. 

Cutting (Ctrl + x) 
When you are creating documents on your computer, you often want to move texts 
from one place to another. There are the Cut and Paste functions built in the pro-
grams to move the objects. 

Four steps of cutting: 
1 Select an object (text etc.) 
2 Cut it by clicking the Cut button or pressing the keys Ctrl + x. 
3 Choose the location where you want to place the object. 
4 Paste the object with the Paste button or pressing the keys Ctrl + v. 

Pasting (Ctrl + v) 
The cut or copied object can be pasted into a new location in the document with the 
Paste function. You can paste the last copied or cut object into the same document or 
other documents as many times as you want. 

Two steps of pasting: 
1 Choose the location where you want to place the object 
2 Paste the object with the Paste button or pressing the keys Ctrl + v. 
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Accessories 
Vista has useful accessories. You can do basic calculation with the Calculator, write 
short messages with the Notepad and draw bitmap images, or paint pictures, with the 
Paint drawing program. The most important program is the Character Map. With the 
help of it you can add special characters into files made with any programs. 

You can find the accessories on the Start menu by clicking the submenu All Programs 
and then clicking the command line of the program in question under Accessories. 

Calculator 
Windows operating systems have for years had the Calculator accessory. The Calcu-
lator functions as any pocket calculator. With it you can quickly do basic arithmetical 
operations with the help of mouse or keyboard. 

 

Figure 16 With the Calculator you can do basic arithmetical operations. Click the 
number, click the operand, click the number and finally click Enter. 

Notepad 
The Notepad is a basic text editor which you can use for writing text. You can’t for-
mat the text; bold, italicize or change the character size. The text file saved with the 
Notepad will get the extension .TXT. This kind of a file contains so called ASCII-
text. 

 
Figure 17 You can use the Notepad to make notes and save the file with the Save 

command on the File menu. 
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Character Map 
You find the special characters in the Character Map program of the Windows op-
erating system. You can add special characters to files created with any program by 
copy-pasting. You can find the Character Map program in the System Tools sub 
group of Accessories. 

Snipping tool 
With the help of the Snipping tool you can capture pictures from windows and parts 
of windows in Microsoft Windows. You can paste pictures into most programs with 
the Paste command or Ctrl + v. 

You can capture the whole screen in the traditional way, in other words by pressing 
Print Screen. You can capture the active window by pressing Alt + Print Screen. The 
picture can also be pasted into several programs. 
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Paint drawing program 
You'll get the Paint drawing program Along with Vista. By using Paint you can paint 
bitmap pictures. When you save files with Paint, the extension of the files is .JPEG. 

 
Figure 18 You find the drawing tools on the left side of the window. The color set-

tings are done under the menu bar and the drawing area is the place 
where you actually do the drawing. In the menus you can find more 
commands, which you can use to edit the picture and the window. 
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Creating drawings 
Use the Paint program to create a self-portrait. Remember that your opinion is as 
good as mine when it comes to art. All artists, like for example Salvador Dali, are al-
ways right in their own opinion. 

Saving drawings 
You should save the good drawings by clicking the Save command on the File menu. 
The first time you save a file a dialog box will appear, where you can give the file loca-
tion, name, saving form and file type. Then click the Browse Folders button. 

You can modify the drawing by opening it and making the changes you want. First 
open the Paint program and click the Open command on the File menu. Choose for 
example D: disk and open the Pictures folder. Choose the Xxxx’s self-portrait file 
and click Open. Make the changes. 

Renaming drawings 
The successful changes should always be saved. You can save the file by clicking the 
Save command on the File menu. Then the file will be saved with the earlier name in 
the same folder where you opened it; it will replace the file with the same name. 

At the second saving time you can rename the file, save it to a new location or save it 
as another file type. To do so, click the Save As command on the File menu. A dialog 
box will appear. Make the necessary selections in the dialog box and finally, click 
Save. 

Printing drawings  
A good drawing should always be printed out. Before printing you should preview 
how the drawing will appear on paper. Click the Print Preview command on the File 
menu. You can print the drawing by clicking Print. 

Program's version number  
Open the Paint program. You can normally find the version information on the pro-
gram's Help menu by clicking the last command About Paint. 

 

Figure 19 The About Paint dialog box gives you program version information. 
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Control Panel 
You can use the Control Panel tools to change the settings of the computer, desktop 
and the programs. You can change desktop settings, like colors and background using 
the accessories of the Control Panel. You can install programs or define network 
connections and other settings. You can open the Control Panel by clicking the Con-
trol Panel command on the Start menu. 

 
Figure 20 In the picture you can see the Control Panel program. The tools of the 

Control Panel are divided into ten groups. Choose the accessory, with 
which you want to change the settings of the operating system. By click-
ing the group name you can open the accessory window of the program 
in question. In that window click the program line to open the accessory. 
The most important accessories have been highlighted with red and they 
are introduced on the next pages. 

You can also look at the Control Panel in Classic View, just click it. The advantage 
of the classic view is that you can see all the accessories in alphabetical order. This is 
of good use to you, especially if you are familiar with the Control Panel of the earlier 
Window versions. 
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Display 
Using the Adjust screen resolution function you can bring into use two monitors. 
You can change the number of the colors and the refresh rate. Increase the display re-
fresh rate to at least 72 MHz, in order to avoid flickering of the display. 

 

Figure 21 The Display Settings dialog box, where you can adjust the screen resolu-
tion and the colors of your monitor. 

Screen Saver 
When you are using the computer, you often have to interrupt your work. To save the 
monitor, you can keep the screen saver on. The accessory in question will fill the 
screen with animated images. 
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Keyboard 
The Regional and Language Options dialog box will appear by clicking the 
Change keyboards button. 

Mouse 
In the Hardware and Sound section of the Control Panel there is a control pro-
gram (driver) for the mouse. In the Mouse Properties accessory you can among oth-
er things define what happens, when you click the mouse buttons. 

Calendar and Clock 
An internal battery-driven clock keeps time on your computer. This will make it easier 
for you to find files when looking for them using the modifying dates. 

 
Figure 22 You can set the time with the Control Panel's Clock, Language and Re-

gion command in Date and Time accessory. However, it is easiest to do 
by following the instructions given below. 



 
 

KJK 

KJK 

 

© Kari J. Keinonen 38 

Sound 
Modern computers often have speakers or a microphone. They enable you to listen to 
music, record speech, look at movies and even edit music files with your computer. 

You can change sound settings in the Control Panel's Sound accessory. 

 

Figure 23 When you open the Sound accessory you see in the Playback section all 
the sound devices installed in your computer. The green mark on the 
lower corner of the icon means that it has been set as the default device. 
You can change the default device by clicking the Set as Default Device 
command on the context menu of the device. You can change the setting 
of the device by selecting the device and clicking Configure. 
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Printers 
By clicking the Control panel's Printer button you can change the settings of your 
printer. In the window that will appear, you can see all the printers connected to your 
computer. The Default printer you are using is marked with a green circle with a 
white mark. The default printer is the printer that prints when you click Quick Print 
in any program. 

 
Figure 24 In the Printers window you can see all the printers connected. In 

the picture the default printer is hp deskjet 845C printer. You can 
change any printer connected to your computer to be the default printer 
by clicking the Set as Default Printer command on the context menu of 
the printer. 

Adding printers  
You can install a new printer in your computer in many ways. Some general printers 
for personal use are automatically installed to Windows Vista, when you connect the 
USB cable to the USB port of the computer. With some printers you get an installa-
tion disk, from which you install the printer's control program. Network printers can 
be installed in the Control Panel program's Printers window by clicking Add printer. 

Next, let's install a local, personal printer: 

 
Figure 25 Open the Control Panel and the Printers accessory. Select the Add print-

er command. Click Add a local printer in the appearing dialog box. 
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Managing Printing 
After clicking Print in any program, the file to be printed will move to the printing 
queue. If you realize that printing is not necessary, you can stop printing in the print-
ing queue of the printer. 

Printing can also be paused because of a mistake. Then your computer's printing 
queue will stop. In this situation, don’t reprint, but remove the documents from the 
queue before you continue printing. It is also recommendable to restart the printer 
before continuing printing. 

On both of these situations, open the printing queue by double-clicking the button in 
the taskbar.  

 
Figure 26 In the dialog box that will appear, you can select the file you don’t want 

to print anymore. Stop printing with the context menu’s Pause command. 
You can continue printing by using the context menu’s Resume com-
mand. To print the file all over again use the Restart command. You can 
cancel printing with the Cancel command. 

All printing functions of the printer can be paused by clicking Pause Printing on the 
Printer menu. All printing jobs can be cancelled from the queue with the Cancel All 
Documents command. 
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Problem solving 
Task Manager 

Unfortunately Windows Vista and its programs are not perfect, and they crash every 
now and then. This means, that the program no longer functions and the program 
crashes at some point for a long time. Sometimes you can see this when Not Re-
sponding message appears. Sometimes you can see the Busy cursor on the screen, 
when the program is not working any more. 

When this happens you can try to solve the problem with a "three finger touch". 
Hold down the Ctrl + Shift keys and press the Esc key. This way you can make the 
Windows Task Manager to appear. 

If this doesn’t solve the problem, you should restart the computer. Always use the 
Reset button if you have one in your computer. If you cannot find it, turn the com-
puter off by pushing the power button. In some computers you must hold the power 
button down for 5 - 8 seconds before the computer shuts down. You seldom have to 
turn off the power by using the main power switch (you can often find it in the back 
panel of the computer) or plugging off the computer. 

System information 
You often need information about your computer. You might find it interesting, what 
is the size of your hard disk and main memory and which Windows version you have. 

The size of the hard disk or folder is easy to find out by using the Properties com-
mand in the appearing dialog box (additional information Figure 10 and Figure 14). 

To see the memory size press the Ctrl + Shift + Esc combination. You can see the 
size of the memory in the appearing dialog box in Performance section. 

or and the size of the main memory. 
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System Tools 
The System tools are often professional accessories for fixing and/or making the 
system more effective. You can find the system tools on the Start menu's Accesso-
ries submenu in the System Tools group. 

You should have Administrator rights to be able to use the system tools of Windows 
Vista, such as defragmenting and organizing. 

Disk Defragmentation 
You can see the state of a disk by using the Properties command on the context 
menu of the disk. In the Tools section of the dialog menu there is the Defragment 
now button to enable the defragmentation. This should be done by using the default 
scheduling. By doing this you can speed up the use of the disk. 

Defragmenting large disks can take a long time, so have a cup of coffee while the 
defragmentation is going on. 

Disk Cleanup 
You can clean up the disk by clicking Properties on the context menu of the chosen 
disk. In the appearing dialog box, click Disk Cleanup button on the General tab. 
Clean up of the disk will give you more space, especially when you allow unnecessary 
temporary files to be deleted. To decide which files are unnecessary is another thing, 
be very careful when deleting the files. 
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Data security 
All definitions of data security1 approach the subject with the same principle: organi-
zation’s information is its most important and valuable asset. This information must 
be secured, it must stay reliable, in the correct format and available only to the desig-
nated people. 

According to Hakala, Vainio and Vuorinen, the most common definition of advanced 
data security consists of five factors: 

 confidentiality 
 availability 
 integrity 
 indisputability and 
 access control. 

Confidentiality is retained by securing the hardware and database by using user names 
and passwords. To retain availability, the efficiency and the condition of the device 
must be taken care of (e.g. page 42). Integrity is managed by "controlling" the input 
data in the programs. Input data must always be correct and it must not be deliberate-
ly or unintentionally changed. Indisputability means that the information system is 
able to identify and save information about the persons using the system. Access con-
trol means the methods to restrict the use of the information system. 

Maintaining data security is a more demanding challenge than what anyone could im-
agine. It also contains physical risk management: avoiding water and sewer system 
damages, ventilation maintenance and pest control. Hardware security management is 
e.g. securing continuous power supply and over voltage protection. Software security 
is taken care of by using only proper and up-to-date programs. 

Securing power supply  
The computer must be shut down carefully, and that is why it is important to use the 
shut down command. During the shutdown, the changes in the operating system set-
tings will be saved on the hard disk. Due to the controlled shut down, the computer 
will next time start up correctly. 

Even though thunderstorms and crashing of the power supply don’t happen very of-
ten in many countries, it is still good to take precautions against them. Thunder will 
cause power failures and power surges. Problems in the distribution of electricity will 
shut the computer down without control, and this should not happen. Specific UPS 
devices have been developed to prevent these problems. There are batteries, which 
help the computers to gain reserve power. This device will take care of continuous 
power supply and over voltage protection as long as the computer can be shut down 
safely before the power supply finally ends. 

                                                 
 
1 Tietoturvallisuuden käsikirja, Hakala Mika, Vainio Mika and Vuorinen Olli, Docendo Finland Oy, 2006 
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User identification 
In many organization, users of the computers log in with a user name and a pass-
word. The control system will check the rights of the user. There are many levels of 
rights; the position of the user and the fact how demanding his or her tasks is define 
the rights. The management of the organization decides the level of the user rights 
and the rights are defined by the system administrator. 

The most comprehensive user rights of the system belong to the system administra-
tor, who can do almost anything in the system. The system administrator controls the 
network, grants others rights and makes sure that the network functions properly. 
The end user of the system has the rights to use the basic programs, use the network 
services and Internet pages. 

The portable disks and computers often identify the user with a smart card or finger 
prints. This is a good way to protect the portable device, since they are easily lost or  
stolen and valuable information may fall into the wrong hands. 

Network safety 
Most violations against data security are done in the internal network. Employees of 
the organizations commit these violations intentionally or unintentionally – by just 
being careless. You should remember not to be negligent; it can cost you your job. 
Don’t copy unnecessary programs from the Internet and don’t use Internet pages that 
are questionable or not permitted. 

Always log out of the system when you leave your job at the end of the day. Logging 
out can be done by selecting the Log Off command from the Shut Down submenu 
on the Start menu. You can also log out by pressing the Ctrl + Alt + Del combina-
tion and clicking the Log Off button in the appearing window. After this, the work-
station can only be used by a person entitled to do so, by using his or her own identi-
fiers, for example you, when you return to the workstation. 

Access control is every employee's right and obligation. I doubt you would leave a 
hundred dollar bill on your desk and the door unlocked when you leave your office. 
Why should you then leave much more valuable and confidential papers lying around 
the office? Always lock the door both at work and at home when you leave the build-
ing. 
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Firewall 
The Firewall is taking care of the external network safety. The Firewall is a device or a 
program, which prevents unauthorized external use of the workstation. Vista has a 
light Firewall program, which is sufficient for domestic use. For example the F-
Secure antivirus program has a Firewalls program. See that both firewalls are not 
running at the same time. Firewalls used in organizations can be heavy devices strictly 
controlling data communication. 

Other Security Settings 
In the Windows Security Center you can also find information about Internet-
security settings and user account control. 

 
Figure 27 In the Windows Security Center window you can see that in my comput-

er the recommended Internet security settings are in use and that User 
Account Control is turned on. 
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Malware Protection 
Malware programs always cause problems and extra costs. These programs and the 
problems they cause should be taken seriously. All actions concerning malware pro-
grams should be taken with extreme care.  

How do malware programs affect my computer? 
A malware program is a sick program programmed by a sick person. Malware is very 
infectious and spreads easily. Malware's intention is to damage the computer that is 
infected by it. The Windows instructions define malware as a harmful program, which 
copies itself and spreads from one computer to another. Malware can harm the sys-
tem, programs and files. 

In addition to malware, also spy programs spread on the Internet. A spy program can 
take your usernames and passwords and send them to criminal hands. 

Most of the malware nowadays spread via the Internet. Downloading programs and 
files from the Internet is always dangerous and when doing so, you take a risk on 
harming your computer. 

Malware very often spreads via e-mail attachments, so don’t open attachments you 
receive from strange sources. 

How to protect your computer from malware? 
Malware Protection is switched on in the Windows Security Center. This means 
that the Windows Defender program, which comes with Vista, is protecting my sys-
tem from malware.  

Virus Protection is enabled (On). It tells me that there is an antivirus program in-
stalled into my computer and it is up-to-date. You can buy antivirus programs in the 
stores selling computers and programs. There are good free programs available on the 
Internet for domestic use. 
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Program installation 
Remember that you are not allowed (and normally even able) to install any pro-
grams at work. Your organization’s system support takes care of program installa-
tions. At home you can install programs, but be very careful while doing it. In the fol-
lowing example the avast! virus program is installed, but you can install nearly all oth-
er programs in the same way. 

If you don’t have a good antivirus program, download avast! from the website  
mentioned on the previous page. Follow the instructions when downloading the pro-
gram. Also do the required registration, without the registration the program func-
tions only for a limited time. When you have downloaded the program into your hard 
disk in a suitable folder, you can install it. 

Installation 
Move to the folder where you downloaded the installation file. Double-click the set-
upeng.exe program icon. When Windows tells you that "program needs an approval 
to continue…" answer by clicking Continue. Read the message that will appear and 
continue by clicking Next. Also read the following message and click Next again. 

 

Figure 28 Click I agree in the License agreement window and click Next. Accept 
the installation path in the next window by clicking Next. Then approve 
also the next window by clicking Next. Furthermore, still accept the In-
stallation Information window in the same way. 
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Back up 
Backing up is an effective way to secure information systems. Backing up means regu-
lar copying of information to another storage medium. By backing up you can restore 
information to the system in case the original information is damaged, lost or stolen. 

In your organization, back up files will be done by the IT departments every day, 
normally at night time. The system and the servers are not backed up so often. Back-
ing up is done automatically and scheduled in tape drives. Backing up is done to dif-
ferent tapes. Tapes are changed every day, and for example all day tapes are separately 
saved for one week. One day tape will be kept as a week tape for a month and one 
week tape will be kept as monthly tape for a year. These tapes will be stored in a dif-
ferent location than the original information, and the storage must be fireproof. 

Back up 
It is important that you back up your files regularly. Back up your important and val-
uable information at home every day, and less important information once a week. 
Store the backups somewhere else, like at work. 

Normal copying from one storage medium to another is enough. In the Control 
Panel there is Backup and Restore Center accessory, which you can use to back up 
information and restore files to your computer. 

At home you can save your back up files to CD or DVD disks. All storage media  
will at some stage be damaged, some quicker than others. You can also save your 
back up files to an external hard disk or another internal hard disk. Saving the files  
to a shared hard disk is not recommended. When the hard disk is damaged, all parts 
of it are useless. 

 

Restore 
You should learn how to restore files before any problems arise. It is important to 
know how to restore information, if the original data is lost or damaged. It is too late 
to learn to restore, when the information is already lost. However, on the Microsoft 
website you can find instructions on restoring information if the backup file is saved. 
At the moment at least the Windows XP restore instructions could be found. 

Restore the data by using the Control panel's Backup and Restore Center utility 
(page 48). 
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Using Help 
Even an IT expert needs sometimes assistance in data processing. Windows Vista 
has a good online help and support. By reading this section you get additional infor-
mation about different functions. 

You can get additional information by clicking Windows Help and Support on the 
Start menu or pressing the F1 function key. Help topics have been divided into six 
parts below. 

Reading Help 
You can open Help by clicking the icon. Then select the topic, when you see the 
contents of it in the window. 

 

Figure 29 The Windows Help and Support window and The desktop (overview). 
Familiarize yourself with the topic; you'll see that it offers a rather ex-
haustive presentation of the desktop. 

Clicking F1 opens The Help window in all programs.  
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